
Lesson-31 

MS Excel-II  

Learning Objectives 

• To understand how to use built-in functions 
• To understand the concept of using + operator 
• To understand how to set arguments 

Using Excel’s Built-in Functions  

The following activity shows how to use Excel’s built-in functions in calculations:  

1.   Employing the SUM Function to Compute Sales Totals 

One of the Excel built-in functions is the function SUM that, as its name suggests, 
computes sums of values in a range of cells. 

To do this, delete the formula in cell B10 (refer to figure 31.1 of lesson 31), type an = 
sign and select the Function Selection dialog box (the symbol fx) from the toolbar. 
(Refer to cursor position in figure 32.1). After that, a dialog box will be displayed and 
one can choose from among the many Excel built-in functions. In figure 32.1, we 
have selected the SUM function from the Most Recently Used function list. After 
making the selection, close the Function Selection dialog box. 

 



 
 

Figure 32.1-- Function Selection dialog box 

2.   Setting the Argument-- A Range of Cells 

After closing the Function Selection dialog box, a second dialog box would appear as 
shown in figure 32.2. The purpose of this dialog box is to help one to set the 
arguments for the chosen function. In this example, the spreadsheet guesses that we 
wish to sum the cells (starting with the first one from the top with numerical data in 
it) immediately above the formula cell. In other words, it selects a range of cells 
B3:B9. This is almost correct. We probably do not care to include the empty cell B9, 
so we edit the range to read B3:B8 and then click OK. 

The dialog box also has a brief explanation of what the function that we have selected 
does and what its arguments stand for. And it even tells us what the result would be 
for the arguments it has pre-selected for us. 

 



 
 

Figure 32.2-- Dialog box after closing Function Selection dialog box  
 
3.   Completing the Formula 

Once we adjust the arguments to be of the range B3:B8 and click OK, we get the 
results as shown in figure 32.3. In a moment, we can replicate the SUM function 
across the row to cells C10, D10, E10. The SUM calculation differs from the previous 
calculation made with the addition formula. 

 
 

Figure 32.3-- Results after adjusting the arguments 

4.   Comparing the SUM Function and a Formula using the + operator 

The SUM function is a convenient way to compute sum when we expect the amount 
of data in our spreadsheet to expand or contract in the future. The reason is that the 
SUM function automatically accounts for inserting and deleting data within the range 



of cells in its argument. The formula constructed with the + operator will not adjust 
for this accommodation. 

Let us modify the spreadsheet to illustrate. Suppose, we had organized a special 
promotion sale at the end of February and now, we want to include these sales figures 
as a separate row in our data. It is easy to add more data in a spreadsheet by inserting 
rows (or columns) into the worksheet. 

Figure 32.4 shows the procedure of adding a row after the February sales figure row. 
First, select the row before which you wish to insert a new row. Do this by clicking 
the row number at the right of the worksheet-- the entire row will be highlighted. 
Then, select the Rows choice from the Insert menu as shown figure 32.4. A new 
blank row will be inserted before the selected row. 

 

 
 

Figure 32.4-- Adding an extra row 

To complete the modification, we add appropriate data to new row 5, as shown in the 
figure 32.5. 

It should be noticed that the total for Region 1 is automatically updated to include the 
additional $10,000 we just entered in cell B5. However, the total for Region 2 does 
not include the new amount in cell C5.  



The formula in cell C11 changes to keep exactly the same values in the sum as were 
there before the insertion of the new row. The new value is omitted altogether. The 
SUM function incorporates the new row as a part of its new range. 

Hence, the SUM function and the + operator are adjusted in different ways for the 
insertion of new data. In order to delete it, select row 5 again and then select Delete 
from the Edit menu. 

As a final adjustment to the worksheet in this step, replicate the SUM function 
formula in cell B10 to cells C10, D10 and E10.  

 

Figure 32.5-- New row added 

5.   Computing Average Sales Per Month for Each Region 

Next, add formulas to calculate the average monthly sales for all the three regions. 
Figure 32.6 illustrates entering the appropriate formula for computing the Region 1 
monthly average. It should be noticed that here we are employing a built-in function 
Average. If we know the function’s name and purpose already, we can simply type 
the formula. Alternatively, we could consult the Function Selection dialog box as we 
did for the SUM function earlier. 

In figure 32.6, we are entering the formula directly. The figure illustrates that instead 
of typing in the range B3:B8, we can drag over that range of cells (note the dotted box 
surrounding the selected range) to indicate the range when the time comes for the 
function’s argument to be entered in the formula. We would complete the formula by 
typing in the closing right parenthesis and then clicking the green check mark on the 
left of the formula bar. 



Once the average is computed for Region 1, replicate the formula to cells C12, 
D12 and E12 to compute monthly averages for the other regions and for the total 
monthly sales. 

 
 

Figure 32.6 

6.   Computing the Standard Deviation of the Averages 

As a final illustration, suppose we wish to compute the standard deviation of the 
averages we just calculated. Copy the procedure given in step 5 and enter a formula 
employing the built-in function STDEV for computing the standard deviation for the 
Region 1 monthly average. (Refer to figure 32.7) Now, replicate the standard 
deviation calculation to cells C13, D13 and E13. 



 
 

Figure 32.7 

The completed worksheet should have the following figures in it. (Refer to figure 
32.8) Check your work against these numbers and locate and correct any errors. 

 
 

Figure 32.8 
 
Exercise 
 
Computing Car Payments 



 

In this exercise, you will get a chance to practice employing an Excel built-in function on 
your own. Suppose, you wish to compute the monthly payments you would have on a car 
you would like to buy. Suppose, the car costs $10,000 and you know you can secure a 
10% annual interest rate loan for this amount. 

You would like to do an analysis to decide what term (pay-back time) you should try to 
get. Ofcourse, the longer the term, the lower your monthly payments but the more interest 
you pay over the life of the loan. You want the shortest term for which you can still 
swing the monthly payments. 

Set up a worksheet like the one in figure 32.9 to calculate the various payments for 
different terms. It should be noted that you can type a long text string (like the one shown 
here in C2) and it will overflow to adjacent cells to the right as long as there is no date in 
those cells. 

 

Figure 32.9 

Excel has a built-in function for computing loan payments. It is called PMT and can 
be found in the financial function list as shown in figure 32.10. 



 
Figure 32.10 

The arguments for the PMT function hold the interest rate (Rate) for the period in 
which you are interested. In this case, it includes the following: 

• A month in this case 
• Number of periods (Nper) you expect to pay 
• Present value (Pv) or amount of the loan 
• Future value (Fv) of the loan-- this will be 0 if you intend to pay the loan off 
• Type (Type) of payment to be made-- this is 0 if your payments begin at the 

end of the month you get the loan, 1 if the payments begin immediately when 
you get the loan (0 is the most common option here) 

Convince yourself that the arguments for your function should be the following: 
(Refer to figure 32.11) 

 



 

Figure 32.11 

The completed worksheet should have the figures as shown in figure 32.12. Check 
your work against these numbers and correct any errors. The parentheses and red 
typeface indicates that these numbers represent a payment (negative). 

 
 

Figure 32.12 
  

Problem Parameters and Absolute Addressing 

The following activity introduces the concept of identifying and isolating problem 
parameters in your calculations.  

1.   Adjusting Sales Figures for Commissions Paid 

Suppose, we want to add an additional row of data for our regional sales summary. 
This row will contain the total sales figures (for each region and the grand total) 
adjusted for commissions paid on the sales made. We will further assume that the 
current commission scheme calls for a 5% commission rate on all sales but this 
commission rate may be adjusted upward later after the yearly sales total is 
considered. 



Since this rate is likely to change, it will be convenient to isolate it in our worksheet 
model rather than bury its actual value within formulas. If we were to put the actual 
value in a variety of formulas, we would have to adjust each formula once the rate 
changes. But if we isolate the rate in a cell and refer to it symbolically in our 
formulas, we only have to change its value once when it changes. The worksheet then 
makes all the necessary adjustments in the calculations for us automatically. 

Modify figure 31.1 by adding the documentation for a new row of adjusted figures. It 
should be noted that this text is in two rows-- cells A15 and A16 and formed by 
adding a cell (and documentation) for the sales commission rate. These changes are 
illustrated in figure 32.13. 

 
 

Figure 32.13 

2.   Developing the Formula for Adjusted Sales 

Now we can easily develop a formula for the adjusted sales figure for region 1 by 
employing the commission rate and the previous sales total. Figure 32.14 illustrates it. 
One should understand the logic behind the formula before entering it in one’s 
worksheet in cell B15 as shown. 



 

Figure 32.14 

3.    Replicating the Adjusted Sales Formula 

Once we enter our new formula, the calculation for the adjusted sales in region 1 
would be displayed. We can check that this is correct as it should be equal to the 
previous sales figure less 5%. Since the calculation is correct, we can now replicate 
the formula to cells C15, D15 and E15. Figure 32.15 shows the worksheet in 
preparation for that replication. 

 



 
 

Figure 32.15 

4.    Locating and Correcting an Error 

Once the formula is replicated, we should check the other adjusted sales figures. The 
sales figures for cells C15, D15 and E15 are identical to the previous sales figures in 
cells C10, D10 and E10.  

What went wrong? Click on cell C15 to examine the replicated formula and you will 
discover the error (refer to figure 32.16). The commission rate variable is now cell 
D18. This occurs because this cell reference was moved one to the right (just as the 
other references were) when we replicated the formula one cell to the right. But cell 
D18 contains no data. Therefore, the spreadsheet assigns it the value 0 which explains 
why no commission was subtracted. 

 



 
 

Figure 32.16 

How can we correct this error? We want the reference to the commission rate to 
remain at cell C18 when we replicate the formula in cell B15. To accomplish this, we 
should override the default relative addressing mode in Excel. We do this by 
designating the cell and row values in our formula with a preceding $. Figure 32.17 
shows this adjustment being made to the formula in cell B15. The resulting cell 
reference $C$18 is called an absolute address and will anchor this cell to remain fixed 
in any replication of the formula.  

 



 

Figure 32.17 

5.   Checking our Corrected Worksheet 

Once we change the cell reference for the commission rate to an absolute address and 
replicate the formula once more, we will get the correct results. (Refer to figure 
32.18) If your figures do not match those shown, check your work for errors. 

 



 
 

Figure 32.18 

Note 

We can change just one of the row or column addresses to be absolute if we choose. In 
this case, it would have sufficed to make only the column address absolute for the 
commission rate. In other words, we could have used the address $C18, leaving the row 
address relative. This works here because we do not replicate the formula to another row. 
Hence, there is no change in the row reference in the replicated formulas anyway. While 
this is acceptable, it is usually a good idea to go ahead and make both the row and 
column addresses absolute for problem parameters. Then we are protected if we redesign 
the worksheet later and make replications in a different way than we originally planned. 

Exercise 

Make your Car Payment Worksheet more General 

In this exercise, you will modify the previous exercise you did for computing car loan 
payments. In the previous exercise, we computed payments for a fixed loan amount 
($10,000) and interest rate (10%) while varying the loan term. A better (more general) 
worksheet would allow us also to vary the loan amount and interest rate.  



Begin by changing the worksheet title documentation, i.e. taking out the reference to the 
loan amount and interest rate. After that, add cells to contain the loan amount and interest 
rate as two problem parameters. Figure 32.19 shows all these changes. We have also 
inserted a column (new column C) to open up some space in the modified worksheet. To 
do this, click on old column C's name in the column label row and access the Column 
command in the Insert menu. 

 
 

Figure 32.19 

To complete the exercise, modify the formula (arguments in the PMT function) in cell 
D6 to use the problem parameters (loan amount and interest rate) symbolically by cell 
reference instead of as explicit values. Then you should be able to use the worksheet 
to compute loan payments for a variety of situations.  

Check your calculations against the ones shown in the figure 32.20 for a $12,000 loan 
at interest rate 9%. If there is a discrepancy, find your error and correct it. 

 
 

Figure 32.20 
 
Notes 
 



 
1. The following steps show how to use Excel’s built-in functions while performing 

a calculation: 
 

• Employing the SUM function to compute sales total 
• Setting the argument-- A range of cells 
• Completing the formula 
• Comparing the SUM function and a formula using the +operator 
• Computing average sales per month for each region 
• Computing the standard deviation of the averages 

 
2. The following steps introduces the concept of identifying and isolating problem 

parameters in the calculations: 
 

• Adjusting sales figures for commissions paid 
• Developing the formula for adjusted sales 
• Replicating the adjusted sales formula 
• Locating and correcting an error 
• Checking our corrected worksheet 

 
Note 
 
Questions for this lesson will be provided by the instructor. 
 
 
 
 
 
 

 


